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1. Document Overview 

The installation and setup guide has been revised to expand the installation 
procedures and to conform to Lucent Technologies’ nomenclature standards. 

This document is a step-by-step guide to installing the Advanced Reporting 
System with the Advanced Traffic Collector.  

Note: If you are installing the Advanced Reporting System without the 
Advanced Traffic Collector, do not use this Installation and Setup 
Guide. Consult the PlexView Advanced Reporting System Master 
Checklist for the correct installation guide for your application. 

2. Advanced Reporting System with Advanced Traffic Collection Setup Overview 

This overview presents guidelines that you should consider when planning 
where to co-locate servers before deploying this Advanced Reporting System 
with Advanced Traffic Collection into your network.  

The Advanced Reporting System with Advanced Traffic Collection is a 
distributed application consisting of many servers. The Advanced Traffic 
Collection system supports either centralized or distributed data collection 
architectures, allowing extensive scalability and flexibility. That flexibility is 
necessary to capture and analyze large volumes of data. 

Co-locating some servers supports best performance practices. For example: 

• Having the EMS and the Advanced Traffic Collector on the same subnet 
assures optimum system performance for inter-machine communication 

• Having the Business Objects client on the same subnet as the EMS assures 
best performance when exporting a universe or creating and executing 
reports 

Instructions for optimizing database layout to enhance performance within 
each server are included within this document. 

The Advanced Reporting System with Advanced Traffic Collection is a 
distributed application that must be installed sequentially according to these 
instructions. All installation steps are listed in order. For some advanced third-
party software configuration that goes beyond the scope of a general 
installation and configuration, you will be referred to the third party 
software’s company’s installation or configuration instructions. 

Note: A qualified IT professional should do all installations or upgrades. 
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Each installation section in this document is presented in the sequence that 
leads to a correct installation. Installing or configuring the component parts 
that make up the Advanced Reporting system out of sequence can lead to 
undesirable results. 

3. Advanced Reporting System Licensing Overview 

The following licenses are required for the PlexView Advanced Reporting 
System with Advanced Traffic Collection: 

• EMS license for StatsCollector software for Advanced Traffic Collection 
• Business Objects Inc. and Oracle Inc. licenses for the PC. 

Licensing information is available on the PlexView EMS License Readme CD 
included in your Advanced Reporting CD package. Please allow two business 
days for licenses to be emailed to you prior to installing this Advanced 
Reporting System with Advanced Traffic Collection. 

4. Prepare and Install or Upgrade the Advanced Traffic Collector 

4.1 Advanced Traffic Collector Overview 

The Advanced Traffic Collector application runs on its own Sun workstation 
and has its own database. The traffic collector does not depend on the EMS in 
any way. The EMS does depend on the traffic collector and will establish an 
ODBC connection to the traffic collector to access traffic data. The PlexView 
Advanced Reporting Traffic Collector Software CD provides the 
StatsCollector database and the StatsCollector application for the Advanced 
Traffic Collector workstation.  

Starting with Release 9.7, the Oracle database will be installed in a separate 
procedure.  

Note: The workstation that will be the Advanced Traffic Collector must not 
have any prior versions of Oracle on it. If it does, Oracle must be 
COMPLETELY uninstalled before installing StatsCollector software. 
Verify that all Oracle files in /var are removed as well. Failure to 
completely uninstall Oracle can produce undesirable results. 

The Advanced Traffic Collector with StatsCollector software is shown in the 
following figure. 
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Figure 2. StatsCollector on the Advanced Traffic Collector Workstation 

 

4.2 Advanced Traffic Collector Hardware Partitioning 

The Advanced Traffic Collector workstation has three hardware partitioning 
options listed in the Advanced Reporting System Software Release Notice. 
The three options are: 

• Minimum configuration 
• Standard configuration 
• Ideal configuration 

Note: An IT professional should execute your configuration choice. 

This section provides details about partitioning. Options include: 

4.2.1 Advanced Traffic Collector Minimum Configuration Option  

Use one 36G hard drive or two 36G hard drives with one drive acting as a 
mirror. The operating system (OS) and Oracle database reside on the same 
physical disk partition, but this degrades performance.  

Set up these partition parameters: 

• Swap  2 GB 
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• /  4 GB 
• /usr 4 GB 
• /opt Allocate the remaining space 

Note: The same configuration applies whether the dual server disk is mirrored 
by Sun Solstice or by Veritas Volume Manager. 

Note: If mirroring is not used, the system should be periodically backed up, so 
that the data can be recovered if the disk fails. 

4.2.2 Advanced Traffic Collector Standard Configuration Option  

Use two 36G hard drives. To improve performance, put the operating system 
and the Oracle database on separate physical disk partitions. Set up these 
partition parameters for disk 1: 

• Swap  2 GB 
• /  4 GB 
• /usr 4 GB 
• /opt Allocate the remaining space 

Set up these partition parameters for disk 2: 

• /opt/PlexView/Oracle/ora02  36 GB 

Note: Periodic backups are required. 

4.2.3 Advanced Traffic Collector Ideal Configuration Option 

Use Two 36G hard drives with one drive acting as a mirror and use a RAID 
Level 5 device for data read/write. Putting the operating system and Oracle on 
separate physical disk partitions on the active drive and putting the Oracle 
data on a RAID device eliminates the need for periodic backups. 

Set up these partition parameters for the disks: 

• Swap  2 GB 
• /  4 GB 
• /usr 4 GB 
• /opt Allocate the remaining space 

For the RAID level 5 device: 

• Mount as /opt/PlexView/Oracle/ora02 

Note: Periodic backups are not required. 
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4.3 Optimize Disk Layout for the Advanced Traffic Collector 

The Advanced Traffic Collector can process high-volume traffic data if you 
optimize its physical database layout. System performance will improve if you 
add additional physical disk drives and map them to the Oracle data 
directories. Lucent recommends that each directory map to a separate disk. 

Note: An IT professional should perform this disk layout setup. 

Mount the additional disks to the following directories: 

/opt/PlexView/Oracle/ora02/oradata/statsdw/data 
/opt/PlexView/Oracle/ora02/oradata/statsdw/system 
/opt/PlexView/Oracle/ora02/oradata/statsdw/rbs 
/opt/PlexView/Oracle/ora02/oradata/statsdw/index 
/opt/PlexView/Oracle/ora02/oradata/statsdw/redo 

4.4 Installing or Upgrading the Advanced Traffic Collector Workstation 

If you are installing the Advanced Reporting Traffic Collection Stats Collector 
Install CD for the first time, use the Install section 4.5, then skip Upgrade 
section 4.6, and go to Setup section 4.7.  

If you are upgrading the Advanced Reporting Traffic Collection Stats 
Collector software, use the Upgrade section 4.6, and go to Setup section 4.7. 

4.5 Install StatsCollector on the Advanced Traffic Collector Workstation 

This procedure is for a new installation on a workstation that does not have 
any versions of Oracle on it.  

Note: For upgrades, do not perform this procedure. Go to section 4.6. 

 

Caution: Using the install files to perform an upgrade will result in the loss of 
all data in the StatsCollector’s Oracle database. To preserve existing 

Lucent Technologi
data, use the upgrade procedure in section 4.6. 

1. Copy the following files from the PlexView Advanced Reporting 
Traffic Collection Stats Collector Install CD to the /opt directory: 

stats.tgz 
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install.sh 

 

2. Once these files are in the /opt directory, go to the /opt directory and type 
the following command: 

/opt/install.sh 
3. When the install script exits successfully, reboot the system by typing in 

the following command: 

sync; sync; reboot 
4. After the system reboots, run a script that will automatically resize the 

database table spaces for StatsCollector. Go to the root directory and 
execute the following command:  

/opt/PlexView/Stats/CurrRel/init-db.sh  
If the script does not output any error messages, then it ran correctly. 

5. Set the ‘plx’ and ‘oracle’ user account passwords as root using the 
following commands: 

Type plx as the password. 

passwd plx 
You will be prompted to enter and re-enter new password. Use plx 
6. Type oracle as the password. 

passwd oracle 
You will be prompted to enter and re-enter new password. Use oracle 

7. Stop this procedure. Go to Section 4.7.0. 

4.6 Upgrade StatsCollector on the Advanced Traffic Collector Workstation 

This procedure is for upgrading the software release on workstations that 
already have StatsCollector and its accompanying Oracle database. 

Note: To optimize Oracle physical database layout prior to performing this 
upgrade, contact Lucent Technical Support for assistance. 
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Caution: Do not use this upgrade procedure to install StatsCollector for the 
first time. To install for the first time, use the install procedure in 
section 4.5. 

1. Stop the StatsCollector using the following command:  

/etc/rc3.d/S99PLXStatsCollector stop 
2. Copy the following files from the PlexView Advanced Reporting Traffic 

Collection Stats Collector Install CD to the /opt directory: 

statsup.tgz 
upgrade.sh 
3. Once StatsCollector is stopped and these files are in the /opt directory, go 

to the root directory and type the following command: 

/opt/upgrade.sh 
4. Continue on to the next section.0. 

 

4.7 Set Up StatsCollector on the Traffic Collector Workstation 

After you have completed the installation or upgrade, you must modify some 
files to enable the StatsCollector software to operate properly. 

 

1. Edit the /opt/PlexView/Stats/CurrRel/stats.cfg 
properties file. Set the following properties accordingly: 

switches=<comma-separated list of switches 
stats will be collected for> 
tsaa_path=<absolute path of directory the 
tsaa will ftp stats files to> 
Note: For Release 9.7 and later, the TSAA path is provisioned automatically 

and writing a path statement tsaa_path is unnecessary. 

For example: 

switches=hottawotta,greenmonster 
tsaa_path=/opt/PlexView/Oracle/ora02/plxstat
s 
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Note: The switch name in the TSAA software in the Billing and Traffic 
application and the switch names in the StatsCollector software in the 
Advanced Traffic Collector must all be identical to the switch’s SID 
name as displayed in the status bar of the EMS Navigator. 

4.8 Start StatsCollector 

2. After you have edited the stats.cfg file, start the StatsCollector software. 0. 

To start StatsCollector, type: 

/opt/PlexView/Stats/CurrRel/Stats.sh start 
Note: If the script indicates that StatsCollector is already running, stop it and 

restart it to avoid possible errors. 

 

Caution: Never terminate the StatsCollector software by using the kill 
command. If you use the kill command, the StatsCollector threads 
could terminate during database operations, producing undesirable 
results that include, but are not limited to, performing lengthy database 
rollbacks. 

You have completed installing and configuring the Advanced Traffic 
Collector workstation.  
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5. Prepare and Load the EMS with Advanced Reporting Software 

There are three steps to be performed on the EMS to support the Advanced 
Reporting System with Advanced Traffic Collection (ATC). 

1. Provision the EMS to access the ATC workstation data 

2. Optimize the EMS’s Oracle database for ATC workstation data 

3. Load WebIntelligence on the EMS and provision it Advanced Reporting.
0. 

Figure 3. EMS Server in an Advanced Reporting System 

 

To provision the EMS correctly, you must know: 

• The location and name of each remote ATC workstation, or the IP address 
if no Domain Name Server is set up 

• The name of every switch that each ATC workstation will collect statistics 
on 

You can use any PlexView client to configure the EMS to support advanced 
reporting. All necessary information can be entered into the Add or Modify 
switch dialogs. 

Refer to the PlexView EMS Installation documentation for instructions on 
how to install or upgrade the EMS or the PlexView client. 
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Note: An IT professional should perform this setup and installation. 

5.1 Set Reporting Switch Properties 

From a PlexView client, set the reporting switch properties in the EMS. This 
must be done for every switch that will report through the Advanced 
Reporting System. 

1. On the PlexView client, Select Actions>Add or highlight the switch you 
want to receive Advanced Reporting data from, right-click and select 
Modify. 

2. From the Modify Switch screen, click the Stats Configuration tab, as 
shown in the following figure. 

Figure 4. Configuration Screen with StatsCollector Information 

 

 

3. Fill-in the fields as follows: 

• CPU Monitoring: Disabled by default. Monitors the active SP’s CPU 

Note: The CPU Monitoring field may be under the Stats Configuration tab or 
the Configuration tab, depending on the release of EMS software. 
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• Host Name: hostname or IP address of the ATC workstation 

Note: If using the hostname, make sure that any DNS in your network can 
resolve the hostname. 

• Global Database Name: statsdw.telica.com 

Note: The Global Database Name, if not statsdw.telica.com must match the 
database identifier in the tnsnames.ora file in the Oracle database. 

4. Click Apply to save the settings or Ok to save the settings and exit. 0. 

5.2 Set Oracle Database Advanced Reporting System support 

The Oracle database already installed in the EMS has a default number of 
open_links=4. This number of links is insufficient to accept input from 
multiple Advanced Traffic Collectors when creating report views and must be 
changed. To change the maximum number of open links, perform the 
following steps: 

1. Access the file using the following path: 

/opt/PlexView/Oracle/ora01/app/oracle/admin/
plxdb/pfile/<initplxdb.ora> 
2. Open the file and find the number of open links. The default is 

open_links=4. This default may not be present in some files. 

3. Change the number to open_links=50, or if the default does not 
exist, add the command to the file. 

4. Save the file. 

5. To complete this procedure, perform one of these two choices: 0. 

• Reboot the EMS server. 
• Shutdown Oracle and restart it. If you don’t know how, reboot the server. 

5.3 Install WebIntelligence on the EMS Server 

Install the WebIntelligence Server on the same Sun workstation as the 
PlexView EMS Server. The PlexView Advanced Reporting 
WebIntelligence Install CD contains the WebIntelligence software.  
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5.4 Install WebIntelligence 

Use this procedure to install WebIntelligence. WebIntelligence must be 
installed by root. 

1. Mount the PlexView Advanced Reporting WebIntelligence Install CD 
to the CD drive. 

2. Copy the following files to the /opt directory. 

webinst.tar and webinst.sh 
3. To install the WebIntelligence Server: From root: execute:  

./opt/webinst.sh  

The script will guide you through the installation. You will also be notified 
when the installation is complete.  

Start the WebIntelligence server using the following command. 

/etc/rc3.d/S99PLXWebIntelligence start 
4. This completes the setup and installation of WebIntelligence on the EMS 

server. You may now proceed to the next section. 0. 
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6. Prepare and Load the Business Objects PC 

The next step in the installation sequence will be to set up the Business 
Objects PC. Co-locate this PC on the same subnet as the EMS server for best 
performance. 

Caution: This software should be installed on a new PC. Never install this 
software on a PC that has ever had an instance of Oracle on it.   

Note: This PC must be dedicated to Advanced Reporting. You can, however, 
use this PC as a WebIntelligence client, combining the top-right box 
and top-left box shown in the following figure. This PC will still be 
dedicated to Advanced Reporting with the Business Objects client on it. 

The key components required on this PC, and included with this Advanced 
Reporting System software package, are: 

• An Oracle client 
• Supervisor from Business Objects, Inc.  
• Designer from Business Objects, Inc. 

These components all reside on the Business Objects PC. 

Figure 6. Setting up the Business Objects PC 
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6.1 The Oracle Client 

Install the Oracle client on the Business Objects PC first. The Oracle client is 
required for Business Objects to communicate with the universe 
repository/database. 

Note: It can take up to 30 minutes to load the Oracle Client. 

6.1.1 Install the Oracle Client 

To install the Oracle client, execute the install script from the PlexView 
Advanced Reporting Oracle Client CD.  

1. Insert the PlexView Advanced Reporting Oracle Client CD into the PC’s 
CD drive. The Client’s Autorun main screen will appear in a minute. 

2. Select the Install/Deinstall Products button from the Autorun main screen. 

3. The Oracle Universal Installer screen will appear in a minute, as shown in 
the following figure. 

Figure 7. Oracle Client Universal Installer Screen 

 
4. Click the Installed Products button to verify that no Oracle products have 

ever been installed on this PC. The results should be similar to the results 
shown in the following figure. 
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Figure 8. Oracle Installed Products Screen 

 

 

Caution: This PC should never have had any instance of Oracle on it. If any 
Oracle products have ever been installed on this PC, the PC will not 
behave correctly, even if all installed Oracle products have been 
removed. 

5. Click Close the Inventory window. The File Location screen should still 
be visible. 

6. Select the default source and destination locations from the File Locations 
screen, as shown in Figure 7. If changing the destination, write down the 
destination file path. You will need it later. 

7. Click the Next button. 

8. When the Installation Types screen appears, as shown in the following 
figure, select the Application User radio button and click the Next button. 
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Figure 9. Application User Installation Type Screen 

 
9. A screen with a summary of all software that will be installed will appear 

in a minute. Click the Install button. 

10. After some installation time, a configuration assistant screen appears, as 
shown in the following figure. 

20 of 44 Lucent Technologies 



PlexView Advanced Reporting System with Advanced Traffic Collection Installation and Setup 
Section 141-300-000 Issue 5, January 11, 2005 

Figure 10. Configuration Assistant: Welcome Screen 

 
11. Click the Cancel button. These tools are unnecessary for this application. 

If you receive an Are You Sure prompt, select Yes again. 

Note: Do not use the Net8 Configuration Assistant. Be sure to click Cancel. 

12. An End of Installation screen appears, as shown in the following figure. 
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Figure 11. End of Installation Screen 

 
13. Click the Installed Products button. Your screen should tell you what 

software is installed, and the results should be similar to those shown in 
the following figure. 

Figure 12. Installed Oracle Products Screen 

 
14. Click the Close button. 

15. On the End of Installation screen shown in Figure 11, click the Exit 
button.  
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16. Please remove the CD from the drive. You have completed this part of the 
installation. 0. 

Once the Oracle Client software is installed, the next task is to configure the 
Oracle Client for advanced reporting. 

6.1.2 Configure the Oracle Client 

Configure the tnsnames.ora file to define the remote database that Business 
Objects will connect to.  

1. From the EMS server, FTP or copy the source file tnsnames.ora 
from: 

/opt/PlexView/Oracle/ora01/app/oracle/produc
t/8.1.7/network/admin/tnsnames.ora 
to the following destination location on the Business Objects PC: 

c:\oracle\ora81\network\ADMIN\tnsnames.ora 
Note: The destination path is the default path. If you change the destination 

path, enter the appropriate path to the Oracle client and note the change. 

2. No further operations are necessary. The Oracle Client is now configured.
0. 

6.2 Supervisor and Designer Overview 

Supervisor and Designer are both automatically installed when you install 
Supervisor from the Business Objects installation disk. 

 

Supervisor is the Business Objects application that provides user 
administration. This software uses the database connection created by the 
Oracle client to control the groups and users that can login to 
WebIntelligence. 

Designer allows you to export universes to the Business Objects Repository. 
Once a universe resides in the repository, you can develop reports from data in 
the repository. 

6.2.1 Install Supervisor and Designer 

To install Supervisor and Designer, execute the setup/install program on the 
PlexView Advanced Reporting Business Objects CD (1 of 2). The 
installation process installs Supervisor and Designer. Install both now. 
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1. Insert the PlexView Element Management System License Readme CD 
provided with your Advanced Reporting package into the CD drive. 

2. Open the boreadme file and write down all Business Objects license key 
information. 

3. Remove the CD. 

4. Insert the PlexView Advanced Reporting Business Objects CD 1 into 
the CD drive of the PC. The Autorun main screen will appear in a minute. 

5. From the Business Objects Setup Wizard screen, select the default of 
Desktop Products and click the Begin button. 

6. The Installation Overview screen will appear as shown in the following 
figure. 

Figure 13. Business Objects Installation Overview Screen 

 
7. After reviewing the Installation Overview, click the Next button. 

8. The User Information screen will appear and automatically fill in user 
information. Accept the defaults or change the user information as 
appropriate and click the Next button. The Licensing Information screen 
appears, as shown in the following figure. 

9. Access the CD from an external window and open and print the readme 
file. It contains license information required for this procedure. If no 
printer is available, write down the product key and the data access key. 
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Figure 14: Licensing Information Step 2 Screen 

 
10. Fill in the following: 

• Product Key 
• Data Access Key 

from the boreadme file.  

Note: If the boreadme file is not on the PlexView Advanced Reporting 
Business Objects Disk 1 of 2, you can get the file from the PlexView 
Element Management System License Readme CD. 

11. Review the license agreement and click the I Agree button. The Setup 
Profile screen appears, as shown in the following figure. 
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Figure 15: Choose Setup Profile Step 4 Screen 

 
12. Accept the default Stand-alone setup profile and click the Next button. 

The Choose Installation Profile screen appears as shown in the following 
figure. 

Figure 16. Choose Installation Profile Step 5 Screen 

 
13. Accept the default Express profile and click the Next button.  
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14. A couple of prompts may appear. Accept them and the installation will 
begin. Business Objects will load and you will be informed of its progress 
by a status screen, as shown in the following figure. 

Figure 17. Business Objects Setup Status Screen 

 
15. Business Objects will load for up to ten minutes, and then you will receive 

a prompt to put in the second CD, as shown in the following figure. 

Figure 18. The Vol2 Prompt Screen 

 
16. Remove the CD and insert the PlexView Advanced Reporting Business 

Objects 2 of 2 CD into the drive. 

17. Click OK to the prompt shown in Figure 18. The installation will 
complete shortly and you will be prompted to view the readme screen.  

18. Your Business Objects directories will display as shown in the following 
figure. Do not close this window. 

Figure 19. Business Objects Programs Screen 
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19. You will be prompted to check your middleware, as shown in the 
following figure. 

Figure 20. Check Middleware Screen 

 
20. Click the Yes button and you will see a middleware check log as shown in 

the following figure. 

Figure 21. Middleware Check Log Screen 

 
21. After checking the log, the system will respond with the status of your 

installation. You should see the following prompt. 

Figure 22. Installation Successful Screen 

 
22. You have completed the Supervisor and Designer installation for the 

Business Objects PC. 0. 

6.2.2 Configure Supervisor  

 

Define the Repository and universe connections using Supervisor. 

1. Open Supervisor by clicking on the Supervisor icon from the Business 
Objects directory as shown in Figure 19.  
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2. Click the Admin button. When you open Supervisor for the first time, a 
setup wizard will appear, as shown in the following figure. 

Figure 23. Supervisor Setup Wizard Screen 

 
3. Click the Begin button. 

4. Use the default “Run a default installation” as the setup configuration and 
click the Next button. 

5. Define the General Supervisor, as shown in the following figure. Enter the 
appropriate Supervisor account information in all fields and click the Next 
button. 

Note: Copy this account information somewhere you will remember. Invalid 
login attempts later will lock you out of the software. 
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Figure 24. Define the General Supervisor Step 2/5 Screen 

 
6. On the Define the Repository Connection screen, select Oracle Client 

from the pull-down for the network layer as shown in the following figure. 

Figure 25. Define the Repository Connection Step 3/5 Screen 

 
7. Click the Setup button. An Oracle Client screen appears, as shown in the 

following figure. 

30 of 44 Lucent Technologies 



PlexView Advanced Reporting System with Advanced Traffic Collection Installation and Setup 
Section 141-300-000 Issue 5, January 11, 2005 

Figure 26. Oracle Client Screen 

 
8. For the Oracle client repository connection, enter the following: 

• User name: busobj 
• Password: busobj 
• Database: plxdb 

9. Click the Test button to test the database connection. The test should 
succeed and you should see the results shown in the following figure. 

Figure 27. Login Test Results Screen 

 

Note: The server will not respond if you have not copied the tnsnames.ora file 
to this PC and configured the Oracle client as described in section 6.1.2 

10. Click the Ok button. You will return to the Define the Repository 
Connection screen as shown in Figure 25. From that screen, click the Next 
button. 

11. From the Build the Repository screen, click the Next button. 

12. The PC will build the repository and you will see processed scripts scroll 
by in a script window. At the end you will receive a status message as 
shown in the following figure. 
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Figure . Repository Build Results Step 4/5 Screen 

 
13. After the universe domain is created, click the Next button to continue. 

14. Select the default repository from the Repository Access screen shown in 
the following figure and click the Next button. The software will place the 
repository in the LocData subfolder of the BusinessObjects folder. 

Figure 28. Repository Access Selection Step 5/5 Screen 
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15. The repository will be created and you will receive a Repository Access 
complete screen. Click the Finish button to exit. 

16. You will be prompted to create a new general supervisor account. Create 
one now. 0. 

Note: Write down your general supervisor and additional general supervisor 
account information and keep it available. 

6.2.3 Create Users and Groups 

Once you create the repository, you can create groups and user accounts. 
Lucent Technologies recommends that you create a group and set group 
privileges, and then add users to the group. The users will then inherit the 
group privileges. 

The Supervisor’s Guide in the Business Objects documentation describes in 
detail how to create users and groups. That documentation is included under 
the Business Objects Documentation heading from the main menu of your 
Advanced Reporting System documentation CD. 

As a minimum, you may want to create two groups. Create a Write/Read 
group with the following privileges: 

• Create Document 
• Save Document 
• Edit Document 
• Publish Document 
• Read Corporate Documents 

This group needs permissions to create, open, and publish documents. 
WebIntelligence users will belong to this group. 

Also, create a Read-Only group with Read Corporate Document privileges. 

6.2.4 Configure Designer to Create a Universe 

The Advanced Reporting System provides the end-user template called a 
universe and named PlexView.unv. Configure the universe template to 
interact with a specific switch in a specific database. 

To do this, define a database connection. Each universe will map to a switch 
in the network. As such, each universe connection will point to a different 
user account, named after the switch, in the EMS database. The end result will 
be a universe for each switch. 
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6.2.4.1 Configure a Universe 

Note: You will be using the universe supplied on the PlexView Advanced 
Reporting Universe CD and will not need to create universes. You will 
need to make a database connection for, rename, save, and export a 
copy of the provided universe for the PlexView EMS and each switch 
you collect data from. 

This example shows how to configure a global PlexView universe for the 
EMS. The EMS universe must be saved, and exported to the database before it 
can be used to execute reports. However, you can use these same procedures 
to make database connections, rename, save, and export switch universes also. 
The variations between the EMS universe and a switch universe are noted in 
the procedures and are only related to filenames you create, test, select, or 
export. 

To configure a Universe: 

 

1. Insert the PlexView Advanced Reporting Universe CD in the CD drive. 

2. Start Designer from the icon shown at the left. A Welcome to Quick 
Design wizard will appear the first time you open the screen, as shown in 
the following figure. 

Figure 29. The Designer Welcome Screen 

 
3. Uncheck the Run this Wizard at Startup checkbox on the lower left of the 

screen shown in the previous figure and click the Cancel button. 
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Note: The wizard will only appear once if you uncheck the checkbox. You 
will not need to run the wizard because the universe template has 
already been created for you by Lucent Technologies. 

 

4. Select File->Open from the Designer main screen. 

5. Locate the PlexView.unv file from the PlexView Advanced 
Reporting Universe CD. 

6.  Open PlexView.unv from the drive. 

7. You will receive warning messages that you do not have write permission, 
and that you cannot connect to the database, as shown in the following 
figure. Ignore the warning and click the Open button. 

Note: Since the supplied universe is a template, you receive warnings because 
Designer was unable to connect to the Repository. You will set up the 
proper connection in the next steps. 

Figure 30. Warning to Ignore Dialog Box 

 
8. You will see another warning screen, as shown in the following figure. 

Ignore it. 

Figure 31. Another Warning to Ignore Dialog Box 

 
9. Click the Ok button on the warning screen. 

10. You will see the template, as shown in the following figure. 

11. To configure the connection, select Tools>Connections. 
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Figure 32. Template Screen 

 
12. You will see a connection screen. To add a connection, click the Add 

button and, when the Add a connection screen appears, as shown in the 
following figure, select Oracle Client and click the Ok button. 

Figure 33. Add an Oracle Client Screen 

 
13. For the Oracle Client Name: enter a name for the connection, for example, 

telica@plxdb, as shown in the following figure. 

Note: A switch name must be identical to how it appears in the EMS. 
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Figure 34. Test Connection Screen 

 
14. For the Username, enter telica. 

15. For the Password, enter telica. 

Note: Starting with Release 9.7, use busobj/busobj as the user name and 
password. For all releases <9.7, use telica/telica. 

Note: For switches, use <switchname>/<switchname> as the user name and 
password. 

16. For the Database: plxdb. 

17. Click the Test button to test the connection. If the server responds, the 
connection is valid. 

18. Click the Ok button. The list of available connections appears, as shown 
in the following figure. Click the Ok button and the window closes. 0. 
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Figure 35. Connection List Screen 

 

6.2.4.2 Name and Save a Universe 

Once you have created and successfully tested a connection, rename the 
universe to appropriately identify the EMS server or the specific switch it 
represents as follows: 

1. Select File>Parameters. The File Parameters main screen displays as 
shown in the following figure. 

38 of 44 Lucent Technologies 



PlexView Advanced Reporting System with Advanced Traffic Collection Installation and Setup 
Section 141-300-000 Issue 5, January 11, 2005 

Figure 36. Universe Parameters Screen 

 
2. Change the value for the name field to <plexview> for the 

PlexView universe or <switchname> for a specific switch’s 
universe. 

Note: Be sure to use the <switchname> for switches you connected in  
section 6.2.4.1. 

3. Click the down arrow in the Connection field as shown in the previous 
figure and select the connection you created earlier. 

4. Click the Ok button. The Universe Parameters screen disappears. 

5. To save the universe, select File>Save As <plexview> for the 
PlexView universe or <switchname> for a specific switch’s 
universe. 

Note: The switchname universe must have a maximum of eight characters. 
Truncate the switch name to eight characters that accurately identify the 
switch. Example: Hottawatta can be renamed to Hotawata or Hottawat. 
In all other instances, the switchname must be exactly as it appears in 
the EMS. 
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Figure 37. Save Universe As Screen 

 

6.2.4.3 Export the Universe from Designer to the EMS 

Once you have tested the connection, you can export the universe to the 
Repository as shown in the following figure. 

Figure 38. Export Universe to the EMS 

 

Multiple universes can also be exported, as shown in the following figure. 
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Figure 39. Exporting the PlexView Global Universe and Switch Universes 

 

Export a universe as follows: 

1. Select File->Export. The Export Universe main screen appears, as shown 
in the following figure. 
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Figure 40. Export Universe 

 
2. Select the universe to be exported and click the Ok button.  

Note: If you have multiple universes highlighted in the Universes window, 
they will all simultaneously export in one operation. 

3. The universe will be exported and the result will display as shown in the 
following figure. 

Note: If the client or the Business Objects PC is not on the same subnet as the 
EMS server, exporting a universe may take at least ten minutes. 

Figure 41. Results Screen 

 

The universe has been successfully exported. 
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7. Configuring the TSAA 

TSAA is part of the Billing and Traffic Server that supports a switch or 
switches. The Lucent Statistical Analysis Application (TSAA) manages 
creation of files that contain statistics data for a specific switch.  The TSAA 
can be configured to forward these files to the Advanced Traffic Collector. To 
support Advanced Traffic Collection reporting, the TSAA will be set up to 
forward statistical files to StatsCollector. The StatsCollector will then store 
the stats data in the local database. 

TSAA must be configured to ftp stats files to the Advanced Traffic Collector 
workstation into a predetermined directory (such as 
/opt/PlexView/Oracle/ora02/plxstats/) 

using the plx/plx login. Please ensure the predetermined directory exists on 
the Advanced Traffic Collector server and that it can be written to by the plx 
user. Refer to the TSAA setup instructions in the Billing and Traffic Guide for 
more detailed information on TSAA (TCA) setup to support this application. 

Figure 42. The TSAA Function in the Billing and Traffic Server 
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